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1 About this document
1.1 General Information

The Baumer Camera Explorer is the perfect evaluation and configuration tool for GenICam
cameras with GigE, Dual-GigE and USB interfaces and allows you to get to know the extensive
functionality of our innovative cameras.

The tool provides you with an easy to use graphical user interface to test your specific camera
features and allows different camera models to be used simultaneously.

1.2 Warnings in this manual

Warnings draw attention to potential personal injury or material damage. The warnings in this
manual indicate different hazard levels:

Symbol Warning term Explanation
DANGER Indicates an imminent potential danger with high risk of death or

serious personal injury if not being avoided.

WARNING Indicates potential danger with medium risk of death or (serious)
personal injury if not being avoided.

CAUTION Indicates a danger with low risk, which could lead to light or
medium injury if not avoided.

NOTE Indicates a warning of material damage.

INFO Indicates practical information and tips that enable optimal use of
the devices.

1.3 Liability limitation

All information and notes in this manual have been compiled in accordance with the applicable
standards and regulations, the state of the art, and our many years of knowledge and experi-
ence.

The manufacturer accepts no liability for damage due to the following reasons:
n Non-observance of the manual
n Improper use
n Use of unqualified personnel
n Unauthorized conversions

The obligations agreed in the delivery contract, the general terms and conditions and the deliv-
ery conditions of the manufacturer and its suppliers, as well as the legal regulations valid at the
time of conclusion of the contract apply.

1.4 Copyright

Any duplication or reprinting of this documentation, in whole or in part, and the reproduction of
the illustrations even in modified form is permitted only with the written approval of Baumer. The
information in this document is subject to change without notice.
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2 Support
In case of any questions please contact our Technical & Application Support Center.

Worldwide

Baumer Optronic GmbH

Badstrasse 30

DE - 01454 Radeberg

www.baumer.com

Tel.: +49 (0)3528 4386 845

support.cameras@baumer.com

https://www.baumer.com/
mailto:support.cameras@baumer.com
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3 System Requirements
The Baumer Camera Explorer can run on any current x86, x86_64, ARMhf and aarch64 plat-
form. It is available for Windows® 7, Windows® 10 and Linux®.

To run the Camera Explorer on Linux please make sure that at least libstdc++.so.6.0.21 is avail-
able on the system, because it is build with gcc v5.5.0.

If you plan to work with multiple cameras or very high frame-rates simultaneously the required
performance will rise. We recommend an Intel® Core i7 or similar performance class system.

Download latest software for your system: www.baumer.com/camera-explorer

http://www.baumer.com/camera-explorer
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4 Installation
4.1 Windows

There are separate downloads available depending on your installed Operating System.

Please use the download named x86_64 for 64-bit versions of Windows® and the download
marked with x86 for 32-bit versions of Windows®

4.1.1 Installation using the Installer

The msi-installer provides an simple way to install the Baumer Camera Explorer.

INFO
Please be aware that you will need Windows® administrator privileges to use the installer.

INFO
All C++ application require the Microsoft Universal CRT package to be installed on your system.
If your Windows® system is not updated as recommended by Microsoft you might not be able to
start the Baumer Camera Explorer. A error message will appear.
For your convenience, we provide the Windows® Universal CRT package with the installer.

Interactive Installation

1. Start the msi-file for your system.
(e.g. Baumer_Camera_Explorer_x.x.x_win_x86_64.msi)

→ Baumer Camera Explorer Setup appears.

INFO: Start the Setup with the command-line parameter “-h” to get an overview
about the options.

2. Follow the installation process and select the components to install.

INFO: The Filter Driver helps to reduce system load when using GigE cameras and
can be installed optionally.

4.1.2 Installation using the zip-file

We also provide the Baumer Camera Explorer as a zip-file to download. This download can just
be copied to a location of your choice and unpacked. It will run from this location, even from a
USB-Stick. Other than the Baumer Camera Explorer you will also find additional files in the un-
packed folder.

n Baumer USB-driver (required for all Baumer USB cameras) see the folder \drivers\USB\
(administrator privileges are required to install the driver).

n Baumer Filter Driver (optional for all Baumer GigE cameras, better performance with multi-
camera and 10GigE) see the folder \drivers\GigE\ (administrator privileges are required
to install the driver).

n Windows® Universal CRT (only required if your Windows® system is not updated regularly)
see the file \ucrtredist_x64.zip (unpack the content of the file directly into the folder
where you unpacked the Baumer Camera Explorer).
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4.2 Linux
4.2.1 Installation using the package manager

The Baumer Camera Explorer is provided as a deb-file for download. This download can be in-
stalled using the Debian package manager. While installing the package a new rule will be
added to the USB-system required to work with USB cameras. No special drivers are required
for GigE cameras.

Install the downloaded packet

apt-get install xxx.deb

4.2.2 Installation using the tar.gz-file

We also provide the Baumer Camera Explorer as a tar.gz-file to download. This download can
just be copied to a location of your choice and unpacked. It will run from this location, even from
a USB-Stick.

Inside the package you will find a USB-rules file this needs to be installed into the right location
if USB cameras will be used.

Only for USB-Cameras, the provided udev file needs to be copied into the udev rules folder
(e.g. /etc/udev/rules.d/)
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5 Program Start

Windows (if installed via Installer)

Open the Baumer Camera Explorer via Start → All Programs → Camera Explorer

Linux (if installed via the Packet Manager)

Open the Baumer Camera Explorer via Show Applications → Input in search field “Camera Ex-
plorer” → Camera Explorer

INFO
There are several command-line parameters. To get an overview, start with -h (bex-
plorer.exe -h).

If zip-file was used, you have to start the Camera Explorer in the respective unpacking folder.
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6 Connect a camera
Please refer to the technical documentation of your camera for connecting a camera to your
system.

NOTICE
Observe the safety instructions in the respective technical documentation of the camera.
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7 Start Screen
The Camera Explorer can have the following start conditions:

n if no camera is connected, the last snapshot is displayed
n if one camera is connected, a live image is displayed immediately
n if several cameras were connected during the last session, they will be displayed with their

availability marked / If the option Open camera view automatically in the Camera settings
Dialog( - on camera) is activated, the respective camera(s) view will open automatically

n On the Start Screen, you will find a user interface that is separated into several areas, which
are described in greater detail within the following paragraphs.

1
2

3 4
5

6

1 Source Tree 2 Main Menu

3 Cameras / Images 4 Features and Properties

5 Help 6 Log View
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7.1 Source Tree

In this area, all existing sources, cameras and images are displayed in a tree list.

The cameras are displayed in a tree structure starting with the GenTL producer followed by the
available hardware adapter(s) and the connected camera(s).

You can open the selected camera or image by double clicking. This area can be expanded and
collapsed by pushing and pulling the little blue marker. After selecting a camera from the list by
double clicking, a new camera tab with the Camera View will be opened.

This area shows the following icons with functions as described below:

Icon Description
Start search for available cameras or update list. All available cameras recognized
are listened under the respective interface.

Load video (*.brv) from a folder.

Load image(s) from a folder.

Remove image. Selected images are removed only from the GUI and remain in
their storage location.

Open program settings dialog.

Expanded and collapsed the area.

At a certain point, the area closes completely.
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7.1.1 IP Address Configuration

The IP Address Configuration is used to configure the network settings of GigE cameras.

INFO
Enable function: File → IP Address Configuration

INFO
On Linux®, root rights are required for configuration. When you start Camera Explorer, the list of
cameras is empty. The list must be refreshed initially with Refresh button.

This area shows the following functions as described below:

Function Description
Add static ARP entry to avoid packet loss.

This setting results in a static entry in the ARP table of the operating system to
avoid packet loss when sending data to the camera.

INFO: Function is available for Windows only. Administrator rights are re-
quired.

Refresh the settings of the selected camera.

IPv4 Address Manually set an IP address for the selected camera.

Subnet Mask Manual setting of the subnet mask.

Static IP The static IP mechanism sets a specific IP Address and Subnetmask to the
camera. Please specify the IP settings manually.

These settings are sent without verification and are immediately adopted. They
remain valid until an other IP configuration mode is selected.

DHCP Enable DHCP (Dynamic Host Configuration Protocol) mode of device. The
DHCP automates the assignment of network parameters such as IP ad-
dresses, subnet masks and gateways. Use this option, if a DHCP server is
available in your network.

LLA Get IP address with LLA (Link-Local-Address) configuration.

The IP address is determined by the camera using a pseudo-random number
generator from 169.254.0.1 to 169.254.254.

Set selected IP address configuration mode.
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7.2 Main Menu

Several program options can be adjusted here.

7.2.1 File

Function Description
Load Video... Load and show a video file.

Load Image... Load images from folder.

Reset Camera Explorer... Reset the Camera Explorer to default.

INFO: All changes to the user interface and customized set-
tings will be lost.

Load User Configuration... Load a previously saved user configuration. The user configura-
tion contains all settings of the Camera Explorer. The current lay-
out is also saved.

Save User Configuration... Save user configuration. The user configuration contains all set-
tings of the Camera Explorer. The current layout is also saved.

IP Address Configuration Show or hide the IP address configuration Widget.

INFO: The function is only visible in the Source View.
Driver Manager… Start the Baumer Driver Manager. This is a tool to install the

Baumer filter driver.

INFO: Administrator rights are required to start the tool.
Settings... [F10] With this function or [F10] you open the dialog window for pro-

gram configurations. Several program options can be adjusted
here.

Run As Administrator… Restarts the Camera Explorer with administrator rights.

Exit [Alt + F4] Close the Camera Explorer.
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7.2.1.1 Settings

All global settings of the Camera Explorer are adjusted here.

System

Function Description
Buffer and Device Control
Event buffers per view Set the number of event buffer.

INFO: Advanced Option, change only when specifically re-
quired!

Device access mode Set the access mode used to connected cameras.

Read/Write: full access

Read Only: access to read the features only

Exclusive: camera locked for other applications

Use timestamp for calcula-
tion of device frame rates

Uses the image time stamps provided by the camera to calculate
the frame rate. This is more accurate than timing via the PC.

Whether this feature is supported depends on the connected cam-
era.

Allow only local GenTL pro-
ducers (requires restart for
changes to take effect)

Enable this option to allow the Camera Explorer to use only local
GenTL producers found on the system.

Disable this option to allow the Camera Explorer to use local
GenTL producers and other not local GenTL producers (3rd party)
found on the system.

The not local GenTL producers are accessible via the environ-
ment variable GENICAM_GENTL_{64|32}_PATH. This is nor-
mally set during installation.

Image Acquisition
Save and restore image ac-
quisition settings and image
enhancement settings

If this option is activated, the Camera Explorer will save and re-
store the camera related feature settings of the dock Widgets for
all connected camera devices.
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Function Description
Save and restore chunk
control settings

If this option is activated, the Camera Explorer will save the
Chunk Control Settings of the camera.

Activating this option may lead to issues if the camera is used with
some 3rd Party Software products.

Log view
Log feature changes Write a log message for each feature modification.

Log device event info When you activate this feature, all events activated by the respec-
tive camera as part of the Event Control feature are logged.

Maximum number of log
lines:

Here, you can set the maximum number of log lines. If the maxi-
mum is reached, the older log lines will be deleted.

0 = unlimited log lines
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Images

Function Description
Image Output Settings
Output directory Change the directory where image files are stored.

File name File name template for saving of image files.

Additional subdirectories can be added by using of “/” or “\”. Enter-
ing an empty string will restore the default template. Invalid char-
acters will be replaced by “_”.

Possible placeholders

[C] – image counter of the current device

[N] – name of the current device

[U] – user device name of the current device

[Y][M][D] – Year, Month, Day

[h][m][s][z] – Hour, Minute, Second, Millisecond

Default image format Select image format for all image saving functions.

Image quality Set the image quality from 1 to 100 %.

INFO: Do not use for JPEG cameras. Use camera features in-
stead.
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Video

Function Description
Video Output Settings
Output directory Set the directory for saving of video files.

File name File name template for saving of video files

Additional subdirectories can be added by using of “/” or “\”. Enter-
ing an empty string will restore the default template. Invalid char-
acters will be replaced by “_”.

Possible placeholders

[C] – image counter of the current device

[N] – name of the current device

[U] – user name of the current device

[Y][M][D] – Year, Month, Day

[h][m][s][z] – Hour, Minute, Second, Millisecond

Default video format Select video format for all video saving functions.

Split Size Select a suitable split size for the video output file.

INFO: Splitting is only working if the camera has JPEG out-
put.
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View

Function Description
User Interface
Automatic start of image ac-
quisition on live view

Enable automatic start of image acquisition on program start.

Turbo mode for maximum
performance

Maximum performance in receiving and processing image data.

INFO: This mode can cause a high processor load.
Show splash screen on next
startup

Select when to start the software and whether the splash screen
is enabled.

If you turn off the view of the splash screen, you will see the initial-
ization in the System Status window instead.

Show tip dialog on next
startup

If you activate this, the Tip of the day... is shown on the next
startup [Shift]+[F1].

Skip confirmation request
when finishing the program

Disable the query when closing the Camera Explorer.

Show IP address in device
name

Shows the IP address of the camera at the end of the name.

Use a fixed layout for new
image views

If activated the internal standard layout or a user defined layout
will be set for new image views. A user defined layout can be cre-
ated via menu View → Save Layout.

External file viewer Set a viewer for the camera's XML file or the trace file.

Floating Image Views
Columns Set the number of columns for arranging the floating image views.

Rows Try to use this number of rows for arranging the floating image
views.

Arrange on Select the destination screen for arranging the image views.
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Trace

The Trace function allows you to monitor program execution. The following options are avail-
able.

Function Description
BGAPI2 Trace Settings
Disable Trace No trace storing.

Trace to Debugger Trace will be transferred to external debugger.

Trace to File Trace is stored in the specified file.

Show the trace file with the currently selected file viewer.

Select the trace file.

Trace Output
Infos Logging of general information.

This selection creates a high volume of data. Activate only when
necessary.

Warnings Logging of warnings.

Errors Logging of errors.

Timestamp Logs the timestamp of every event.

Timestamp difference Logs the interval from the last traced event to the current one.

Prefix Shows the source (.dll) of the log entry.
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7.2.2 Device

NOTICE
Functionality is available only in Camera View.

Function Description
User Sets Reset...: Reset all camera settings to the default user set.

Load...: Load a a previously saved user set from the PC.

Save...: Saves the current camera settings to a user set on the PC.

Image Storage Save to camera...: Save current image permanently to camera.

Load from camera...: Show permanently stored image from camera.
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7.2.3 View

Function Description
Toggle Left Widget Bar 
[Ctrl]+[Shift]+[L]

Open / Closes the left Widget Bar.

Toggle Right Widget Bar
[Ctrl] + [Shift] + [R]

Open / Closes the right Widget Bar.

Toggle Log View
[Ctrl] + [Shift] + [M]

Open / Closes the Message View.

Display Rotate 90 ° Clockwise

Rotate 90 ° Counter Clockwise

Flip Horizontal

Flip Vertical

Load Layout... Load a previously saved layout from a file.

Save Layout… Saves the current layout to a file.

Set Layout to ‘Delivery State’ Reset the layout to the delivery default.

Rescan
[F5]

Search / Update for available cameras. The available cameras
are listened under the respective interface.

Arrange
[Ctrl+Shift+A]

Open all cameras and tabs (images) in separate windows.

This button is only available if the Open camera view automati-
cally function is activated for at least one camera, or if tabs are
opened.

Settings for Arrange windows: Program settings → View / Float-
ing Image Views

Dock All Views Docks all cameras and tabs (images) in the Camera Explorer.
This feature is only available if the Arrange function was used
previously.
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7.2.4 Widgets

The Baumer Camera Explorer has a flexible, customizable user interface. The user can decide
which of the functional modules (Widgets) should be displayed. Widgets are arranged via a sim-
ple drag and drop into the left and right panes. Widgets can be closed (hidden from the inter-
face) and reopened if required again via the menu.

INFO
The available Widgets differ depending on the view (Camera View / Image View) and the fea-
tures of the connected camera.

Widgets - Camera View (example) Widgets - Image View

Function Description
Histogram & Profile The histogram and profile diagrams is an essential tool for everybody

working with images.

Temperature
(Camera view only)

This Widget offers you the possibility to comfortably monitor the tem-
perature of the camera.

Recorder 
(Camera view only)

This Widget allows to record image-series and videos.

Camera Features 
(Camera View only)

With this Widget you can view and change camera features and can
be used to configure and store the camera features as required by
your application.

Crosshairs Show the options for a crosshairs in the image.

View Settings Widget for view settings like rotate, image format and rendering op-
tions.

Image Format 
(Camera View only)

Change the cameras pixel format and region of interest easily.

Brightness 
(Camera View only)

Here is the central point to configure all related settings of your cam-
era. Use it to understand how different settings relate to each other
and influence the image quality.

White Balance & Color
(Camera view only)

The white balance and color settings combines all settings which in-
fluence the color accuracy of your camera.

Image Acquisition Info 
(Camera View only)

On the widget, you can access additional information about the image
and data transfer.
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Function Description
Serial Interface
(Camera View only)

With this widget it is possible to control a device (e.g. lens, lighting)
connected to UART1 port or UART0 port (depending on camera
model) of the camera from the PC using separate software.

Data Stream Features
(Camera View only)

Containing the features to control the stream channel shared be-
tween the remote device and the GenTL Producers data stream mod-
ule of GigE cameras.

Widgets [} 37]
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7.3 Cameras / Images

The recognized cameras or open images are displayed here.

Cameras

In this area, the connected cameras are displayed with their model name, a status icon and the
serial number. Start the Camera View by double clicking on the icon.

Meanings of the status icons shown as part of the camera icon.

Icon Description
Full access to the camera is available.

Camera accessibility is limited. Features are shown but cannot be
changed.

Camera is not accessible.

Device disabled. Other programs can use the camera instead.

Camera is in the wrong subnet.

INFO: On Linux®, root rights are required for configuration.

Press (+) to assign a temporary valid IP address (forcing).

INFO: The assigned IP address is only valid temporarily. As soon
as the power supply to the camera is interrupted, it is deleted.
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Icon Description
After assigning a temporary IP address you can use IP Address Con-
figuration [} 13] to assign a fixed IP address.

INFO
You can display the IP address instead of the serial number of the cameras.
File → Settings → View → Show IP address in device name

Camera settings Dialog

To the right of the available cameras, there is the option button.

Icon Description
Click this button to open the options for the respective camera.

Function Description
Open camera view
automatically

If this function activated, the respective Camera View(s) will be opened
automatically when the Camera Explorer is next started.

If only one camera is connected, a live image is displayed immediately,
regardless of this option.

Save and restore im-
age acquisition set-
tings and image en-
hancement settings

If this option is activated, the Camera Explorer will save the previous set-
tings for the Image Acquisition Tab and the Image Enhancement Tab.

You can activate this function in the Program Settings. File → Settings →
System (Save and restore image acquisition settings and image en-
hancement settings)

Disable device Disable this device for further use. This ensures other programs can use
the camera without interference from the Camera Explorer.

Images

The captured snapshots and the loaded images are displayed here. Their storage location will
be shown as a tooltip. You can open an image in the Image View by double clicking it.

Remove the selected image with [Del].

INFO
Selected images are removed only from the GUI and remain in their storage location.
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7.4 Features and Properties

Depending on the selected object (systems, interfaces or cameras) in the source tree, the avail-
able properties are shown here. You can view and in some cases change values as required.

1
2

1 Source Tree 2 Features and Properties

(1) Source Tree

The Source Tree lists the available cameras in relation to their respective interfaces (e.g. net-
work adapters) and the GenTL producers (e.g. Baumer GEV TL).

(2) Features and Properties

The features are displayed within their respective category.

This area shows the following icons with functions as described below:

Icon Description
Collapse all feature control categories.

Expand all feature control categories.

Refresh all feature values [F5]. Toggle the feature names with
pressed [CTRL]-Key.

Filtering features by name, value or category. Filtering is not case
sensitive. Several OR linked search strings can be entered separated
by spaces. Searching is done in feature name or display names by
default. A prefix can be used to search in feature values or in feature
categories.

Possible prefixes are:

: - search in feature values (e.g. “:Off”)
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Icon Description
# - search in feature category names (e.g. “#User”)

Display Help for selected feature.

7.5 Help

You can open the help file within the program.

Function Description
Help Open the help file [F1].

Tip of the Day… Open the Tip of the day [Shift]+[F1].

Command Line Parame-
ter…

Here you get an overview of the available command line parame-
ters when starting the Camera Explorer.

Show Changelog… Opens the version history of Camera Explorer in an .md file.

Baumer Industrial Cam-
eras…

Open the homepage about the innovative Baumer products

Homepage… Open the Baumer Camera Explorer homepage.

Check for Updates… Check if a new update is available.

About Camera Explorer… Shows the program version and further information.
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7.6 Log View

In this area, the program activities are shown in chronological order.

Right-click in this area to display different options.

For example, you can access information about:
n starting procedure
n recognized cameras
n occurred errors
n used GenTL producers

INFO
Settings for the Log View can be adjusted in File → Settings → System
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8 Camera View
Each opened camera will be shown in a separate tab (Camera Views). Each Camera View is
separated into into different areas.

1

2

3
4

5

1 Widgets 2 Live Image (with status bar)

3 Play / Record Bar 4 Message View

5 Status Line

(1) Widgets

Widgets can be:
n arranged per drag and drop into the left and right panes
n collapsed and expanded by using the double arrow button in the top left corner
n hidden by using the cross button in the top right corner or via the view menu
n reopened again via the view menu

The arrangements as well as the settings in a Widget are saved and restored if the same cam-
era is reconnected or opened again.

INFO
The available Widgets differ depending on the features of the connected camera.

Widgets [} 37]
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(2) Live Image View

This view shows live images from the camera. The status bar below informs about the current
mode of the camera / image view.

green: live image from camera

gray: camera stopped, last available image shown OR displaying images from recording
OR display image from file

red: currently recording from camera

(3) Play / Record Bar

The following functions are available in this Tool Bar.

Icon Description
Stop image acquisition [F11].

Start image acquisition [F12].

Take a snapshot of the current image [F9].

Start image recording. 
INFO: The settings are controlled in the Recorder widget.

Zoom out [Ctrl] + [mouse wheel].

Zoom in [Ctrl] + [mouse wheel].

Toogle Fit in view mode [F2].

Toogle maximized mode [F3].

Activates full screen mode [F8].
INFO: In full screen mode, you can zoom into/out of the image with [Ctrl] +
[mouse wheel].
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The following functions are available after / during recording.

Icon Description
Restart image recording.

Stop image recording.

Show previous recorded image.

Start replay.

Show next recorded image.

Save current images to file.

Save captured images.

Save captured images to video file.

(4) Log View

In this area, the program activities are shown in chronological order.

Log View [} 29]
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(5) Status Line

The Status Line at the bottom of the Camera View tab gives information about the currently dis-
played image.

1 2 3 4 5 6 7

1 Camera Frame Rate 2 Camera Explorer Frame Rate

3 Frame Size 4 Draw Size [View Mode]

5 Frame ID 6 Coordinates

7 RGB values

No. Description
1 Camera Frame Rate

Current frame rate of the camera (frames per second [fps]).

2 Rendering Rate

Current display / recording frame rate of the Camera Explorer (frames per second
[fps]).

3 Frame Size

Current resolution (Region of Interest) of the image.

4 Draw Size [View Mode]

Current zoom level of the displayed image and image format. Image format switch-
able with [F6].

5 Frame ID

Number of images transferred from the camera since AcquisitionStart. The mouse
pointer must be over the image.

6 Coordinates

Position of mouse pointer within the image.

7 RGB values

The Red Green Blue values for the current mouse position.

INFO: The display format can be changed. Widget 

View Settings →  → Show status line color info in hex mode.
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9 Image View
Each image will open in a separate tab. The image view are separated into different areas. The
content of the areas is described below.

1

2

3
4

5

1 Widgets 2 Image View

3 Tool Bar 4 Message View

5 Status Line

(1) Widgets

Widgets can be:
n arranged per drag and drop into the left and right panes
n collapsed and expanded by using the double arrow button in the top left corner
n hidden by using the cross button in the top right corner or via the view menu
n reopened again via the view menu

The arrangements as well as the settings in a Widget are saved and restored if the same image
is reconnected or opened again.

Widgets [} 37]

(2) Image View

Displays the selected image.
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(3) Tool Bar

The following functions are available in the Tool Bar.

Icon Description
Save current image to file.

Save current image to new file.

Zoom out.

Zoom in.

Toogle Fit in view mode [F2].

Toogle maximized mode [F3].

Activates full screen mode [F8].

INFO: In full screen mode, you can zoom into/out of the image with [Ctrl] +
[mouse wheel].

(4) Log View

In this area, the program activities are shown in chronological order.

Log View [} 29]
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(5) Status Line

The Status Line at the bottom of the Camera View tab gives information about the currently dis-
played image.

1 2 3 4

1 Frame Size 2 Draw Size [View Mode]

3 Coordinates 4 RGB values

No. Description
1 Frame Size

Current resolution of the image.

2 Draw Size [View Mode]

Current zoom level of the displayed image.

3 Coordinates

Position of mouse cursor within the image.

4 RGB values

The Red Green Blue values for the current mouse position.

INFO: The display format can be changed. Widget 

View Settings →  → Show status line color info in hex mode.
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10 Widgets
Widgets can be:

n arranged per drag and drop into the left and right panes
n collapsed and expanded by using the double arrow button in the top left corner
n hidden by using the cross button in the top right corner or via the view menu
n reopened again via the view menu

Widgets can be closed (hidden from the interface) and reopened if required again via the View
menu.

INFO
The available Widgets and the adjustable values differ depending on the view view (Camera
View / Image View) and the connected camera type.

10.1 Histogram & Profile

The Histogram & Profile Widget is an essential tool for everybody working with images.

You can analyze the histogram and the profile of live and captured images over the whole im-
age or just inside a selected area (ROI).

Main Window

INFO: With a right click in the diagram, fur-
ther functions are available.

Start or stop live diagram (Camera
View only)

Selection of an area in the image to
control the Histogram / Profile.

With a right click on the image, fur-
ther functions are available.

Center the current selection (se-
lectable if area is marked in the im-
age).

Refresh with data from current im-
age.

Mode: Histogram: Frequency distribution for
the selected channels.

Profile: Evaluation of the image pro-
file.

Open or close the settings.

Reset diagram settings.
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Settings - View

Show

Red: Show the red channel.

Green: Show the green channel.

Blue: Show the blue channel.

Mono: Show the brightness channel.

Range: Use this settings to shrink the value
range of the x-axes..

Profiles

INFO: Functionality is only available in
Mode Profile (Main Window).

Orientation:

Horizontal: The entire image / marked area is
analyzed horizontally.

Verical: The entire image / marked area is ana-
lyzed vertically.

Calculation

Mean Value: The entire image / marked area is
analyzed in the selected orientation.

Center Line: The image / marked area is ana-
lyzed centrally in the selected orientation.

INFO: The orientation is marked with a yel-
low line in the image / marked area, if you
selected this under: 
Advanced → Show center line.

Settings - Statistics

Channel Data

Here for each selected channel (Red, Green,
Blue, Mono (Brightness) values are displayed.
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Settings - Advanced

Show Pixel Frequency in

Show histogram with absolute frequency val-
ues or with percentages values.

INFO: Functionality is only available in
Mode Histogram (Main Window).
Appearance

Tooltip: Show tooltip info inside the diagram
area.

Show Center line: Show center line for profiles
when calculated with Center Line option.

INFO: Functionality is only available in
Mode Profile (Main Window) and when Cal-
culation: Center Line is selected in the View
Tab.

Info: Show or hide additional info in the dia-
gram area.
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10.2 Temperature (Camera View only)

This Widget offers you the possibility to comfortably monitor the temperature of the camera.

INFO
Emergency shutdown at Overtemperature
To prevent damage on the hardware due to high temperatures, the camera features emergency
shutdown.
Observe the technical documentation of the respective camera.

Main Window

Activate or deactivate the automatic
temperature recording.

Save current temperature data to .csv
file.

Open or close the temperature set-
tings.

Reset temperature diagram and
recorded data.

Settings

Warning: Set the temperature warning
threshold (DeviceTemperatureStatus-Transi-
tion). The green area in the diagram is di-
rectly adapted to your input.

Unit X-axis: Select the labeling of the x-axis.

Interval: Set the measuring intervals in sec-
onds.

Buffer Size: Number of buffers used inter-
nally to store measured values.

Max: Maximum shown temperature value in
the diagram.

Min: Minimum shown temperature value in
the diagram.
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10.3 Recorder (Camera view only)

This widget allows to record image-series and videos.

Main Window

Start recording [F7].

Stop recording.

Restart recording [F7].

Open or close the recorder settings.

Reset all recorder settings to default
values.

Record to

Images: Record the captured images to
disk.

Video: Record the captured images as
video to disk.

Memory: Record the user defined number
of images to memory.

The image and video format can be se-
lected in Settings [} 15] - Images

INFO: Images and Videos recorded with
the Recorder widget are not automati-
cally added into the Images & Video list
of the Source View.
Record

Set the number of images or the duration in
seconds for next recording.

with: Set the camera frame rate for saving.
Disable the checkbox to use the current
frame rate.

into a ring buffer: Save images continuously
in a ring buffer to the PC.

The size of the ring buffer is defined by the
number of images or the number of sec-
onds to be recorded.

INFO: This option is only available with
Record to Images or Memory.
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save every: Record every n'th captured im-
age.

Replay

INFO: The functions are grayed out as
long as no images have been recorded-
NOTICE! .

Current image: Select the current image.

Replay speed: Select the current image re-
play rate.

Settings

Output

Image folder: Current output directory for
saving of images

Image counter: Start counter used in file
names for saving of images.

To use this counter the place holder [C]
must be used in the file name setting.

File name settings: Settings [} 15] – Im-
ages/Video

Video folder: Current output directory for
saving of videos.

Video counter: Start counter used in file
names for saving of videos.

To use this counter the place holder [C]
must be used in the file name setting.

Open current output directory

Opens the global Settings
Menu to configure the image/
video output settings

Settings [} 15] – Images/Video

Event Actions

Here it is possible to control the image
recording via the Digital-IO of the camera.

Select “Off” to disable the respective event
action.

INFO: The number of available Digital-
IOs depends on the connected camera.

Save image: Select a camera input line
with which the image acquisition is trig-
gered.

INFO: This function will not work if im-
age recorder is running.
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Save ring buffer Select a camera input line
with which will save all captured images to
disk.

Start recording: Select a camera input line
with which will start the image recorder.

Stop recording: Select a camera input line
with which will stop recording.

Overrun: Specify the number of images to
be recorded after the “Stop recording”
event. The specification is made as a per-
centage of the size of the ring buffer.
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10.4 Camera Features (Camera view only)

This Widget shows the GenICam conform features provided by the camera. Use this Widget to
change camera settings.

Furthermore you can use it to preset the camera as required by your own application, by perma-
nently store the settings on the camera.

Hover your mouse cursor over the feature value to display brief information in the form of a tool
tip. On the Help you get information about the respective marked feature. To make changes,
click on the value and a editable element is show. Changes can also be made via the keyboard.
Some features correlate with each other and will be immediately updated. Some features can
only be changed if the camera is stopped. (Stop - [F11], Start - [F12]).

INFO
Camera Features

a) The available categories and features depends on the connected camera.
b) Features might be locked depending on other features. The help-window might hold a hint

why a feature is locked.
c) Interdependent features are arranged under a selector category (marked green). The corre-

sponding selector (also marked in green) is placed first.
d) Many widgets offer consolidated access to features grouped into logical functionalities (e.g.

Exposure Time in Widget Brightness). Those widgets will change values in the feature tree
and visa-versa.

e) Please refer to your camera User´s Guide to learn more about how to work with camera fea-
tures, learn about specific features of your camera and how to persist feature settings in the
camera.

1

2

3

1 Collapse all.

Expand all.

Refresh all feature values. Tog-
gle the feature names with
pressed [CTRL]-Key.

Show the GeniCam XML configu-
ration file for the current device.

INFO: You can set your own
external file viewer to show the
camera configuration files. 
Settings → View / External file
viewer
Filtering features by name, value
or category. Filtering is case sen-
sitive. Several OR linked search
strings can be entered separated
by spaces. Searching is done in
feature name or display names
by default. A prefix can be used
to search in feature values or in
feature categories.
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Possible prefixes are:

: - search in feature values (e.g.
“:Off”)

# - search in feature category
names (e.g. “#User”)

Display help for selected feature
(3)

2 This is the Feature control area.

3 Help for selected camera feature.

10.5 Crosshairs

Show the options for a crosshair in the image. The crosshair position in the image can be ad-
justed.

Show
crosshairs

Activate this option if you
want to position a crosshair in
the image.

Color: Select the color of the crosshairs.

Size: Set the size of the crosshairs.

Inner radius: Set the radius of the circle in the
middle of the crosshairs.

Opacity: Set the opacity of the crosshairs.
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10.6 View Settings

Widget for view settings like rotate, flip, display format, rendering options and background color.

Rotate image 90° clockwise.

Rotate image by 90° counter clock-
wise.

Flip image horizontal.

Flip image vertical.

Settings

Reset all view settings to default val-
ues.

Rendering

Set the converting of the image data [F6].

View

Rendering rate: Set the rendering rate. This
setting only affects the display of images in
the camera view. The rendering rate is
shown in the status bar as Draw fps.

Anti-aliasing: Use anti-aliasing transforma-
tion for showing of images.

Pixel clipping: This setting colors black pix-
els in blue and white pixels in red to high-
light areas of the image with unusable con-
tent.

Memory Control

Reserved buffers: Set the number of preal-
located image buffers used for image acqui-
sition.

More image buffers can prevent image loss
but requires a larger memory capacity. Set
only the required numer of buffers (1 buffer
= 1 image).

INFO: The system does not check
whether there is sufficient memory avail-
able.

Use optimal buffer size: Enable this option
to save system memory or to allocate image
buffers as much as possible.

Disable this option to prevent possible dis-
play errors when the size of the allocated
image buffers will become smaller than the
current Payload size.
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Settings

Info

Show info view info bar: Display the current
mode under the image.

Show color info in hex mode Display of the
color information in the Status Line of the
current pixel over which the mouse is posi-
tioned, in hex mode.

Color

Background color: Here you can select the
background color of the image area in the
Camera View.
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10.7 Image Format (Camera view only)

Change the cameras pixel format and region of interest (ROI) easily.

Select an area to change the current
image region.

With a right click on the image, fur-
ther functions are available.

Center the current selection (se-
lectable if area is marked in the im-
age).

Reset image format settings to de-
fault values.

Pixel format

Select one of the available pixel formats
here.

Image Region

X-Offset: Set the horizontal offset from the
origin to the region of interest (in pixels).

Y-Offset: Set the vertical offset from the ori-
gin to the region of interest in pixels.

Width: Select the width of the image region
in pixels.

Height: Select the height of the image re-
gion in pixels.

Set the ROI for the current image (se-
lectable if area is marked in the image).

Binning

INFO: Availability depends on camera
model.

Horizontal: Number of horizontal pixels to
combine.

Vertical: Number of vertical pixels to com-
bine.
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10.8 Brightness (Camera view only)

Various auto features are available to affect the automatic adjustment of image brightness. Here
is the central point to configure all related settings of your camera. Use it to understand how dif-
ferent settings relate to each other and influence the image quality.

Main Window

Toggle automatic brightness control.

Select an area to control the auto
brightness (functionality depending
on camera model).

With a right click on the image, fur-
ther functions are available.

Center the current selection (se-
lectable if area is marked in the im-
age).

This setting colors black pixels in
blue and white pixels in red

Open or close the brightness set-
tings.

Reset all brightness settings to de-
fault values.

Exposure Time

Set the exposure time for the camera.

INFO: If the feature is grayed out, make
the following settings in the Feature
Tree:
ExposureMode = Timed

ExposureAuto = Off

Gain

Controls global Gain as an absolute physi-
cal value.

Target Brightness

Set the nominal value for brightness in per-
cent of full scale. It will be adjust with con-
sider the setting in BrightnessAutoPriority
(Feature Tree → Category: AutoFeature-
Control).

Gamma

Use Gamma Correction:

Controls the gamma correction of pixel in-
tensity. This is typically used to compensate
for non-linearity of the display system (such
as CRT).
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Settings

Control Priority

Select the control priority for auto bright-
ness.

n Exposure Time -> Gain
n Gain -> Exposure Time
n Exposure Time Only
n Gain Only

Exposure Time Range

This setting defines the working range of
the automatic control.

Gain Range

This setting defines the working range of
the automatic control.

10.9 White Balance & Color

The white balance and color settings combines all settings which influence the color accuracy of
your camera.

Toggle automatic white balance &
color control.

Select an area to control the auto
white balance (functionality depend-
ing on camera model / firmware).

With a right click on the image, fur-
ther functions are available.

Center the current selection (se-
lectable if area is marked in the im-
age).

Reset all white balance and color set-
tings to default values.

Demosaicing

Demosaicing is used to calculate an RGB
image from the received raw data.

Select the current demosaicing method to
convert the received image data from the
camera sensor.

INFO: If the camera is already sending
an RGB image, this setting does not mat-
ter.
Sharpening & Noise Reduction

Here you have different options to influence
the sharpness and the noise of the images.
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INFO: Sharpening is only available if the
demosaicing method is set to Baumer
5x5 and if the current pixel format is sup-
ported.

Mode: Select the sharpening mode which
will be used by the image transformation.

n Off
n Global Sharpening
n Adaptive Sharpening
n Active Noise Reduction

Further options for influencing the selected
method, are available in the lower area.

Factor: Here you can adjust the level of
sharpening.

Threshold: Here you can adjust the sensitiv-
ity threshold for sharpening.

Auto Color Matrix Switching

Activate or deactivate the Auto Color Matrix
Switching.

After activating this function, one of the ex-
isting ColorTransformationFactoryList is au-
tomatically selected.

Color Correction

INFO: Deactivate Auto Color Matrix
Switching to make settings here.

Rotation: Set color rotation for merging with
current color matrix.

Saturation: Set color saturation rotation for
merging with current color matrix.

Load Matrix…: Load color transformation
file and gain values from the PC.

Save Matrix…: Save current color matrix
and gain values to file on the PC.
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10.10 Polarisation (Camera view only)

The Camera Explorer can be utilized to view the different formats like AOP and DOLP which are
calculated from the image of polarized camera.

Polarisation Setting

Visible component :Select the polarization
part of the image data for showing in image
view.

INFO: The calculable data can be found
in the respective operating manual of the
camera.

Calibration angle offset:

Adds a calibration offset to compensate for
an individual "roll" angle of the camera, in-
troduced by mounting tolerances. The offset
is added to all type of output data that incor-
porates an angle, like false color represen-
tation and angle of polarization data. The
offset is without effect to raw data and to
degree of linear polarization data.
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10.11 Image/Buffer Info (Camera View only)

On this Widget, you can access additional information about the image and data transfer.

Collapse all

Expand all

Refresh all feature values. Tog-
gle the feature names with
pressed [CTRL]-Key.

Reset the stream statistics of
the current device and some
buffer related counters.

INFO: Some counters can
only be reseted by restarting
the image acquisition.
Clear the Info view.

Filtering features by name,
value or category. Filtering is
case sensitive. Several OR
linked search strings can be en-
tered separated by spaces.
Searching is done in feature
name or display names by de-
fault. A prefix can be used to
search in feature values or in
feature categories.

Possible prefixes are:

: - search in feature values (e.g.
“:Off”)

# - search in feature category
names (e.g. “#User”)

Show help for selected camera
feature.
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10.12 Serial Interface (Camera View only)

INFO
The Widget is only available for Windows® 64bit.
The com0com driver must be installed to use the serial camera interface. If the com0com driver
is not installed, the functionality in this Widget is grayed out.
Download driver: https://com0com.sourceforge.net/

With this Widget it is possible to control a extra device (e.g. lens, lighting) connected to UART0
port or UART1 port of the camera from the PC using the original configuration software from it's
manufacturer..

The communication commands with the extra device are fed directly into the camaera data ca-
ble. No extra cable is needed. This requires additional software (com0com) to define a COM
connection between two virtual COM ports.

This COM connection connects Camera Explorer to the configuration software. In the Widget,
one virtual COM port is used to connect it to the UART of the camera. The second virtual COM
port must be set in the configuration software.

Schematic structure

separate 

software

Camera

PC

Camera

Explorer

Firmware

UART0*
UART1

*) depending on model

virtual Com Connection (co
m

0
co

m
)

Connections

Connect: Contains the available UART ports of
the camera.

to: Contains the available virtual COM port pro-
vided by com0com.

Reset all serial interface settings to
default values.

Connect selected UART with se-
lected com0com Port.

Info

Number of ports detected.

https://com0com.sourceforge.net/


Baumer Widgets | 10

V3.4 | Baumer Camera Explorer Software Manual 55

10.13 Data Stream Features (Camera view only)

Containing the features to control the stream channel shared between the remote device and
the GenTL Producers data stream module of GigE cameras. These are the features of the data
stream. They are independent of the connected camera.

Collapse all.

Expand all.

Refresh all feature values.

Filtering features by name, value
or category. Filtering is case
sensitive. Several OR linked
search strings can be entered
separated by spaces. Searching
is done in feature name or dis-
play names by default. A prefix
can be used to search in feature
values or in feature categories.

Possible prefixes are:

: - search in feature values (e.g.
“:Off”)

# - search in feature category
names (e.g. “#User”)

Display help for selected feature.



11 | Shortcuts Baumer

56 Software Manual Baumer Camera Explorer | V3.4

11 Shortcuts
Below you can see the shortcuts available in Camera Explorer. With them the Camera Explorer
can be operated more quickly.

Setting Shortcut
Help [F1]

Tip of the day [Shift] + [F1]

Image view fit to window [F2]

Toggle maximized mode [F3]

Exit [Alt] + [F4]

Search / Update camera devices [F5]

Disable / Enable the converting of the image
data

[F6]

Start image recording [F7]

Full screen [F8]

Snapshot of current image [F9]

Program Settings… [F10]

Stop image acquisition [F11]

Start image acquisition [F12]

Remove selected image [Del]

Select all images [Ctrl] + [A]

Manual image enlargement [Ctrl] + [mouse wheel]

Scroll in zoomed image [Alt] + [mouse] / [Shift] + [mouse]

Open / Closes Left Widget Bar [Ctrl] + [Shift] + [L]

Open / Closes Right Widget Bar [Ctrl] + [Shift] + [R]

Open / Closes Message View [Ctrl] + [Shift] + [M]

Arrange [Ctrl] + [Shift] + [A]

Dock All Views [Ctrl] + [Shift] + [D]
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